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Topographical Information

Topographical information is a key component of any
hydrological model

Topographical data tells the model where ridges and
valleys, mountains and hills, rivers and streams, and
other important features are

Without topographical information, it would be
impossible to route water downstream or to produce
any forecast of stream flow or soil moisture
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Topographical Information

It takes many different forms, but in EF5 we need three
pieces of topographical data

DEM — Digital Elevation Model

FDR — Flow DiRection (also called DDM in EF5)

FAC — Flow Accumulation (also called FAM in EF5)

These follow a specific order
You always have to start with a DEM
An FDR is created from a DEM
And the FAC is created from the FDR

This DEM - FDR - FAC process only works in this
direction
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Digital Elevation Models

A DEM is a digital model of the earth’s surface created
from terrain elevation data
Stored as a grid of numbers

Each grid cell has one number and that number is the
elevation of the grid cell in the units of the DEM

These grid cells match exactly with the EF5 model grid cells
we discussed in Module 2.1

Exaggerated vi wf DEM fr mAII Cou yI
(Id Glg al Sur be FRpp)
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Digital Elevation Models

We all know water flows from high points to low points

So if we have a DEM and we give it to the hydrological
model, the model will know where water flows across the

entire domain
In the cartoon, the columns are like an exaggerated DEM

The arrows mark the direction of
the flow of water

The blue arrows are collecting — 1—"/
water from a lot of upstream cells, f l J
or area, so we can think of them < 2 j f
as sort of a main river channel = -

The red allows have less area, so ’ )
we can think of them as “overland VA )
cells”
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Digital Elevation Models

How is a DEM created?

If the area is small enough, it might be created by direct
survey (that is, going out and measuring elevation at many
points)

But usually, remote sensing techniques are used

The earth’s surface is scanned
from space to create a DEM

Done via radar satellite from space — %’/
« RADARSAT, SRTM, ASTER j

™
T~
\$~
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Digital Elevation Models

One of the most important characteristics of a DEM is
resolution

k7 —~ k7 ’
One of these is at 4km horizontal resolution (~5.2 MB)
The other is at 30 arcsecond resolution (~1km at the equator) (~36 MB)

Can you tell the difference?
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Digital Elevation Models

What if we zoom in?

Now you start to see the difference in the Amazon
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Digital Elevation Models

Let’s zoom in one more time...

If you look carefully at the streams in the yIIow box and it becomes clear that
the left image is has a lower resolution than the right image
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Digital Elevation Models

This exercise demonstrates an important point about

resolution:
* In general, the larger the model domain, the coarser the
resolution can be

* Hydrologic models require computing power, and the
number of cells being modeled is directly related to the
computing requirement

« The number of cells being modeled increases as the DEM
resolution increases

« To run large areas at high resolution, fast computers or
more time to run the model are needed
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Flow Direction

A flow direction grid, or FDR, is a grid containing values
that tell you where water is flowing

Imagine flipping our DEM cartoon forward
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Flow Direction

Let’s keep rotating it until we’re looking at it dead-on

Now | have a grid, with the same size, resolution, and extent
as my DEM, and this grid exists only to tell me in what
direction my water is flowing
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Flow Direction

But | need a way for a computer to easily read and
understand this direction grid

The obvious solution is to assign each direction a number
and assign the appropriate number to each grid cell

>|<<<<—’ 175|515 |7
Yy < 1(7]|6|5|5]|7
= <~> 8|7](7]/7|5|6
ey | Y Y 1(1[(1]7]7]|7
LK s 3l2(1|7[5]7
R 3[3[3|7]/5]5
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Flow Direction

This is called a coding scheme

. i 2 & This is the scheme | used (it’s also the scheme in the
el
" TauDEM program

s ] % R
A There are other schemes out there, though, including the one
® used by ArcMap -2

TauDEM D8 Flow Directions Instructions ©
David Tarboton

>|<<<<—’ : 1|7 | 5| 55| 7
viy < 117]|6|5|5]|7
T<V/, s8l7|7]l7|/5]6
ey | Y Y 111|1]|7]7 |7
LK s 3l2(1]7[5]7
J | < 3|3|3l7l5]5
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Flow Direction

You probably noticed that some cells flow
into two or more other boxes

In that case, the computer picks the cell with the
biggest elevation difference (that is, the steepest

descent) and the water flows into it o
>|< “—<—<1] 1175|557
\ < 1|/7/6|5|5]|7
= <~> 8|7]7|7|5]|6
oy | Y 1[1[1]7]7]7
LK s 3l2|1]7|5]7
J | ¢ 3|3(3]7|5]5
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Flow Direction

This is called the eight-direction flow model (or D8) L3
Some important things to keep in mind: ] L] -2

* Your DEM needs to be larger than the entire river s ] m
basin you want to model, because the outer edge of TN

FDR cells will not actually have values in the real ] 0 ]
world, because the computer doesn’t know what’s ° 7 :
OutS'de your D E M TauDEM D8 Flow DirectionsDE\?itéu_lg;ir%g?o%
T T
\ A K

W|Ww|=| of =
W N =] NN
W|=|=| N O
N (NN N o
o ||~ gl o
O NN ol ~
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Flow Accumulation

The third and final necessary component is the flow

accumulation, or FAC

The FAC is a grid of numbers corresponding to the number of
cells flowing into that cell

>|<<<<—’ 1(5|3| 211
Yy < 216[3[2]|1]2
= <~> 3[o9[1]2|1] 3
ey | Y Y 3 |15[18]20] 4] 1
LK s 212|231 5|2
J | < 111|136 4] 3
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Flow Accumulation

Note all the FAC cells with a value of 5 or greater are in blue

Like we mentioned when we first started discussing DEMSs, think of
these as cells in the river channel

You may recall we briefly mentioned the TH parameter in EF5 back in

Module 2.1
That parameter is the threshold for a river channel cell, so here TH
would be 5
<< <1 1153|211
\ < 216[(3[2[1]2
= <~> 3[9[1]2|1]3
ey | Y Y 3 |15(18|20] 4| 1
LK s 212231 5|2
J | < 1111 |36 4|3
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Sources

So where do we get the DEMs needed to make this cool
stuff?
Luckily, there are several free, good quality DEM sources

around the world
We will focus our discussion on SRTM - the Shuttle Radar
Topography Mission

This was STS-99 in February 2000

%
(q)
m
I

/

’),”))M&IJJ;,,?-.-.

uttle Endea = T
February 200 and, Florida STS-99 Mission Insignia
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Sources

SRTM data characteristics

The SRTM data are available around the world at 3
arcsecond (90m) resolution

The original SRTM data have been processed and corrected
for hydrological use

One great source for this is the HydroSHEDS program

Register SignIn  Contact Us

& HydroSHEDS

Overview Development Availability Links HydroBASINS FAQs License Download

August 5, 2014: We would like to announce a new product - HydroBASINS. Read about about HydroBASINS here and follow download links.

This website is currently updated. It should work, but if you encounter any problems please try again later. You also can find HydroSHEDS at the

USGS mirror site (see Links above); but note that the USGS site is no longer updated.
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HydroSHEDS

HydroSHEDS is a World Wildlife Fund project

They provide continent-wide (or sub-continent-wide) DEM,
drainage direction, and flow accumulation grids

Other useful data include river networks and drainage basin
outlines

Their website is hydrosheds.org

& HydroSHEDS
Overview Development Availability Links HydroBASINS FAQs License Download

August 5, 2014: We would like to announce a new product - HydroBASINS. Read about about HydroBASINS here and follow download links.

This website is currently updated. It should work, but if you encounter any problems please try again later. You also can find HydroSHEDS at the

USGS mirror site (see Links above); but note that the USGS site is no longer updated.
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HydroSHEDS

As part of the EF5 training course, we include the necessary
river networks and DEMs for certain model examples
The file names work like this: example[ number| [type].zip

So, example2 dem.zip is a .zip file containing the necessary to
complete Example 2 in the training

BRINE N HydroSHEDS - o IEN
“ Home Share View 0
(—l - 1 » EF5_training » data » HydroSHEDS » v & Search HydroSHEDS P
) . Name Date modified Type Size
{ Favorites ’
B Desktop 1) example2_dem.zip 5/14/201511:53 AM  Compressed (zipp... 26,045 KB
& Downloads ) example2_rivers.zip 5/14/201511:54 AM  Compressed (zipp... 8,752 KB
=1l Recent places & test_dem.tif 2/4/2015 4:28 PM TIFF image 40 KB
1M This PC
m Desktop
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HydroSHEDS

Other important information:
The DEM quality is very good, but not perfect

The river network files are in Esri Shapefile format and the DEMs
are in Esri GRID format

Either can be opened in both Esri ArcMap and QGIS

20 S - HydroSHEDS - o IEE
“ Home Share View @
(—l - 1 » EF5_training » data » HydroSHEDS » v ¢ Search HydroSHEDS j ol
¢ Favorites Name Date modified Type
Bl Desktop 1) example2_dem.zip 5/14/201511:53 AM  Compressed (zipp... 26,045 KB
4 Downloads 1) example2_rivers.zip 5/14/201511:54 AM  Compressed (zipp... 8,752 KB
=\ Recent places & test_dem.tif 2/4/2015 4:28 PM TIFF image 40KB
1M This PC
m Desktop
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Other DEM Sources

There’s also the GTOPO30 project at USGS, which is a
30 arc second (1 km) world DEM derived from SRTM

The raw SRTM data was collected at 1 arc second (30
m), so at 9x the size of the finest HydroSHEDS DEM

Until 2014, this 30 m data was only available in the U.S.,

but is now being released for the rest of the world as
“SRTM-2”

We’ll talk more about SRTM-2 later in the training
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Example 2

Let’s process our own DEM files and create a DDM/FDR and an FAC

7))
Q

Example 2 will be the Bogota River Basin in Colombia upstream of a
gauging station at Puente Portillo
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Getting Ready

In \EF5 training\examples\example2, create a new
folder called ggis

This will be our project folder where we do all the
processing steps prior to running the model

[ LD = | example2 - o IEN
“ Home Share View 0

(—I - 1 » EF5_training » examples » example2 » v & Search example2 P
e Name : Date modified Type Size

B Desktop basic 5/14/2015 1:24 PM File folder
4 Downloads obs 5/14/2015 1:29 PM File folder
i<l Recent places output 2/5/2015 2:07 PM File folder
pet 2/5/2015 2:07 PM File folder
1% This PC precip 2/5/20152:07PM  File folder
m Desktop qgis 5/20/2015 1:46 PM File folder

| Documents control.bxt 5/21/2015 1:27 PM Text Document 1 KB

0 Nawnlazade
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Getting Ready

In \EF5_training\data\HydroSHEDS,
unzip example2 dem.zip to your new

qeis folder
« Right-click, and click “Extract All...”

Select a Destination and Extract Files

Files will be extracted to this folder:

| Ci\Users\raceclark\Desktop\EFS_training\examples\example2\qgis Browse...
Show extracted files when complete | example2_dem
info
* Repeat for example2_rivers.zip ot
* You should now have these files in 3 :::Z:Z’:::Zﬁf:n
your ggis folder 2 ) cxampled_rvers sbx

|| example2_rivers.shp

|| example2_rivers.shx

| example2_rivers.xml
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Getting Ready

Once you’ve extracted the rivers and DEM into your
qgis folder, we’re ready to get started

First, check again that your qgis folder has the files
shown below

Name Date modified Type Size
example2_dem 5/14/201512:01 PM  File folder
info 5/14/201512:01 PM  File folder
|| example2_rivers.dbf 5/3/2006 12:00 AM DBF File 7,291 KB
d example2_rivers.htm 5/3/2006 12:00 AM HTML Document 18 KB
| example2_rivers.prj 5/3/2006 12:00 AM PRI File 1 KB
|| example2_rivers.sbn 5/3/2006 12:00 AM SBN File 3,782 KB
|| example2_rivers.shx 3/2006 12:00 AM  SBXFile 112 KB
|| example2_rivers.shp 5/3/2006 12:00 AM  SHP File 57,804 KB
|| example2_rivers.shx 2006 12:00 AM SHX File 3,432KB
| example2_rivers.xml /2006 12200 AM XML File 11 KB
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Set up the QGIS Project

Now open QGIS Desktop 2.6.1 and “Add Vector
Layer...

Project Edit View |Layer! Settings Plugins Vector Raster Database Web Processing Help

—h Create Layer

Embed Layers and Groups... ru Add Raster Layer... Ctrl+Shift+R
Sl oy RN @, Add PostGIS Layers... Ctrl+Shift+D
Copy style /% Add Spatialite Layer... Ctrl+Shift+L
VS o = Paste style P Add MSSQL Spatial Layer...  Ctrl+Shift+M
# :=| Open Attribute Table @, Add Oracle Spatial Layer... Ctrl+Shift+0
+ ‘ Toggle Editing &% Add WMS/WMTS Layer... Ctrl+Shift+W
@ Save Layer Edits €2 Add WCS Laver...

At the prompt, navigate to your qgis folder and select
example2 rivers.shp

Next, select “Add Raster Layer...” and from your qgis

folder, open the example2 dem folder and then
wo01001.adf
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Set up the QGIS Project

You should see something like this...

L QGIS 2.6.1-Brighton el x|
Project \ Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
M N [ f @& P o FAT - G == 20l — C N
L (3] % RN @ @ o P ﬂ é? 3— JD RS R (R @ & o v 8~ k?
& G T R |G
Layers (&)%) Processing Toolbax &)%)
8 = @@ G .
= % B¢ woo1001 t (- Recently used algorithms
11 Pit Remove
49 08 Fiow Directions
3968 T
x example2_rivers D8 Contributing Area

& & GDAL/OGR [34 geoalgorithms]

& GRASS commands [168 geoalgorithms]

- o8 Models [0 geoalgorithms]

7 @ orfeo Toolbox (Image analysis) [82 geo.
Z QGIS geoalgorithms [85 geoalgorithms]

SAGA [227 geoalgorithms]

Scripts [0 geoalgorithms]

TauDEM (hydrologic analysis) [26 geoalg...

SeSD8 VNSRS

4

Let’s go ahead and save our QGIS project — | named
mine example2.qgs and saved it in my qgis folder
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Set up the QGIS Project

Now we’re going to add our gauge location to the
map
Our gauge is named “Puente Portillo” and it’s on the
Bogota River in the nation of Colombia p New Vector Layer > IER

Create a shapefile layer...

-./«; ® Point Line Polygon

Project Edit View \Layer\ Settings Plugins Vector Raster Database Web Processing Help

File encoding System v
L ‘ Add Layer , EPSG:4326 - WGS 84 Specify CRS
‘ Embed Layers and Groups... New attribute
" . abe abb .xr:o abec abc abc abe
] Add from Layer Definition File... . 5 | p—
o po ‘ Copy style Type |Textdata 4

Click “OK” when the dialog box appears - >

Attributes list
Name Type | Width Precision
id Integer 10
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Set up the QGIS Project

Then you’ll be asked to save your new layer — | named
mine gauge loc.shp

ity Save layer as... | x |
T » EF5_training » examples » example2 » qgis » v ¢ Search qgis e
Organize v New folder SEEIR 2 (7)
- F . X Name . Date modified Type Size
{ Favorites J
Bl Desktop example2_dem 5/14/201512:01 PM  File folder /
& Downloads info 5/14/201512:01 PM  File folder S
- Recent places || example2_rivers.shp 5/3/2006 12200 AM  SHP File 57,804 KB Project Edit View Layer Settings Plugins Vector
-y 1N . o ™
J
/8 This PC L] N ) {)
m Desktop ’ .
‘| Documents L s (X °
& Downloads Toggle Editing Layers
o Music v V;j {@J 3 ? 1] -ﬂ |
File name: | gauge_loc.shp| v E!O X © gauge loc
Save as type: | ESRI Shapefile [OGR] (*.shp *.SHP) v SR .5.4 w001001
e m:
4 Hide Folders Cancel - .
‘/}lﬁ x example2_rivers
a

Then turn on “Toggle Editing” -
A pencil will appear to the left of “gauge_loc”
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Set up the QGIS Project

Now use the “Coordinate:” box at the lower right of the
QGIS window to zoom in to the gauge location

Advanced interface

\@I Coordinate: -70.76,-0.68 i(ale 1:23,805,347 v %/ Render EPSG:4326 \§| \zy

We are looking for -74.6, 4.45

As you zoom in, the numbers in the box get more
precise (there will be more numbers to the right of the
decimal)

We know the river is somewhere in the mountains in
NW South America, which appear as white on the DEM
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Set up the QGIS Project

Once you’re satisfied with how you’ve zoomed in,
select “Add Feature” -

Project Edit View Layer Settings Plugins Vector

DB RBLR [

:é;
P78 [5)B & s

”_Add Feature |
%VES Eﬁ e Y J e

C- % 4 w001001
L 1
#)

35968

f x example2_rivers
(#]

Your cursor will become a circle with crosshairs

Click once at the point on the map where the
“Coordinate:” box says -74.6, 4.45
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Set up the QGIS Project

/ gauge_loc-F.. ? - x

Actions

A small box will appear

id |1

Type “1” in the box and click “OK”
Concel

A dot will appear on the map where you just clicked

Click the pencil above the “Layers” pane of QGIS to
turn editing off, and at the pop-up, click “Save”

# Stop editing x|

"6‘) Do you want to save the changes to layer gauge_loc?
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Let’s review what we’ve done and why we’ve done it

So far, we’ve set up our QGIS project
1. We've extracted our DEM into our project’s folder
2. We've also done that with our river network

3. We've created a shapefile that contains one feature, a
point at the location of our river gauge

These three pieces of information are all we need to create
hydrologically-conditioned topographical grids for EF5

Now on to the next step: Identifying the Basin Extent

Module 2.2 / DEM Derivatives



|dentifying the Basin Extent

In the “Layers” pane, drag
“example2_rivers” above
“w001001” so that the rivers are
plotted on top of the DEM

Now we want to “Select features
using an expression”

In the “Expression” part of the
dialog box, type UP_CELLS >

Note how you see “Expression is
invalid” at the bottom of the box
in red

=l o0
A v
1E =
|Select features using an expressionl
~ — \
4 Select by expression - example2_rivers
Function list Selected function help
t- Operators :\
- Conditional
I Math
[ Convers ions ]
t- Date and Tim
t- String - |
7 Col )
W Operat
/ Il ( )
Expression
UP_CELLS >
< | («]»]
Output preview: id {more info)
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|dentifying the Basin Extent

Now type a number after UP_CELLS >, like UP_CELLS > 10060 and
the red text goes away

Click “Select” and you should also see some rivers change color
in QGIS

When you pick larger numbers, you see only larger rivers
highlighted

When you pick smaller numbers, many more rivers will be
highlighted

You want to pick a threshold that is small enough to capture the
character of the river vou re modeling, plus its major tributaries,
but not so small that you’ve highlighted almost every river. Try to
capture the main river channel "and the major tributaries.
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|dentifying the Basin Extent

The appropriate value varies from basin to basin, but here
let’s try UP_CELLS > 400

Click “Close”

Now we are going to use the “Coordinate:” box, our gauge
location, and our highlighted rivers to try to find the edges
of our basin in latitude and longitude

You don’t have to be perfect, but it is better to pick too much
area instead of too little

In other words, err on the side of including excess area
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Clipping a DEM

Here’s an idea
of what to look
for 2>
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Clipping a DEM

Let’s pick some nice round numbers for this
« The left, or west edge... 75 deg W (or -75 deg)
« Theright, or east edge... 73 deg W (or -73 deg)
 The top, or north edge... 6 deg N
« The bottom, or south edge... 4 deg S

There are two advantages to these edges:

1.  They’re much larger than the actual edges of the river basin, so
we erred on the side of caution!

2. They’re round numbers, so if we need to do any calculations
later, it will be easy!

Now go to the “Raster” menu, “Projections” and click “Warp
(Reproject)...”
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Clipping a DEM

On this screen, click “Select...” by 7 e Reprolect
“Output file,, and then Save to your Batch mode (for processing whole directory)

qgis directory — | use the name - T
c 1 1 p pe d_d em ® t 1 -F %/ Source SRS EPSG:4326 Select...
?Qesampling method Near |~

Then check “Resampling method” :
and pick “Near” =

Memory used for caching | 20MB

4»

Resize

Check “No data values” and type
- 3 2 7 6 8 Use multithreaded warping implementation

% Load into canvas when finished

[4[»
r

gdalwarp -overwrite -s_srs EPSG:4326 C: ‘ ' ‘
\Users\racedark\Desktop\EF5_training\examples\example2\ggis\ ——
example2_dem\w001001.adf ‘ ‘

Then click the pencil icon below
“Load into canvas when finished”
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Clipping a DEM

Now you should be able to type in the
text box at the bottom

After -r near, type -te -75 4 -73 6
-tr 0.02 0.02

“-te” tells QGIS the extent of the grid in
latitude and longitude, so we type the
left border, then the bottom, then the
right, and then the top

And “-tr” tells QGIS the resolution of
the grid in degrees — we are going to
use 0.02 degrees in each direction, ~2
km

Tt file
no e

»

[4[»

4|

® Load into canvas when finished

gdalwarp -overwrite -s_srs EPSG:4326 -1
0.020.02 |-dstnodata -32768 -of GTiff C:

\Users\racedark\Desktop\EF 5_training\examples\example2\ggis\ ‘i‘

example2_dem\w001001.adf

C:/Users/racedark/Desktop/EF5_training/examples/example2/qgi

s/cipped_dem. tif

near -te -754-736 -tr ’:‘

OK

Close Help
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Clipping a DEM

Click “OK”, “OK”, “OK”, and then “Close”

QGIS 2.6.1-Brighton - example2 - 9 IEN
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
™ =l E \ [ G L D @ ®A D 0 Q - < —
=l § A O e PP RPlaido @ @ & fmh ¥ o~
2 bd [ag| @ at el (o b W
Layers =1E3 v T 4 Processing Toolbax &)X
3 > P @ @ Y

S { V
X © gauge_loc \
K s y

- %/ & clipped dem
178
3541

Recently used algorithms
Pit Remove
g D8 Flow Directions
g 05 Contributing Area

X example2_rivers 7 & GDAL/OGR [34 geoalgorithms]
=% B wo01001 % GRASS commands [168 geoalgorithms]
h 1 5 &4 Models [0 geoalgorithms]
3968

Orfeo Toolbox (Image analysis) [82 geo
5 # QGIS geoalgorithms [85 geoalgorithms]

3 SAGA [227 geoalgorithms]
: Scripts [0 geoalgorithms]

TauDEM (hydrologic analysis) [26 geoalg

4

SPEH8IVNANS
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Filtering and Clipping Rivers

Now right-click example2_rivers
and select “Save As...”

Click “Browse” and then save in
your qgis directory as
large rivers.shp

Check “Save only selected
features”

And check “Extent (current: user
defined)”

Then type in the appropriate
values for north, south, east, and
west, the same as we used
before, and click “OK”

¢ Save vector layer as...
Format  ESRI Shapefile v
Save asI C:/Users/racedark/Desktop /EF5_training/examples/example2/qgis/large_rivers.shp Browse I
CRS Layer CRS v
Change...
, (]
Encoding System v
l X Save onlx selected features '
Skip attribute creation
® Add saved file to map
Symbology export No symbology v
w R Extent (current: user defined)
North |6
West  -75 East |-73
South 4
Layer extent Map view extent

W Datasource Options

W Layer Options

) |

P Custom Options
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Let’s review again

We already set up the QGIS project
Then we filtered out smaller rivers

We used that information to determine the extent of
our river basin

Then we clipped the DEM to that extent and reduced
its resolution to make the model run faster

Finally, we saved the filtered rivers (which are also
now on the same exact extent as our DEM)

Now on to the next step: Repairing the DEM
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Repairing the DEM

When we change the resolution of a DEM, we tend to break things
We create “pits” or “sinks” that didn’t exist in the original data

In “Processing Toolbox”, open “TauDEM (hydrologic analysis)”
and then “Basic Grid Analysis tools”, and then double-click “Pit
Remove”

Pick “clipped_dem” in the “Elevation Grid” drop down box and
for “Pit Removed Elevation Grid” click the “...” and “Save to
file...”

Then pick an appropriate location and name (l used
corrected _dem.tif)
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Fixing the DEM

NOW CI iCk t¢ Pit Remove X
ce R u n 73 Parameters | Log | Help

Elevation Grid

dipped_dem [EPSG:4326] - E
When the (Gl sereajommis/om i don —
brocess 3 open autpt e aftr g st
completes
you’ll have a
new “Pit
Removed
Elevation Grid”
in your
“Layers” panel

Run Close
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Converting Rivers

Now we want to “burn” our rivers
into the corrected DEM to make
sure the model knows where the
streams are

Go to the “Raster” menu,
“Conversion” and “Rasterize
(Vector to Raster)...”

1§3e|ect “large_rivers” for the input
ile

And for the output file, | chose
rasterized rivers.tif

Click okay on the pop-up warning

{¢ Rasterize (Vector to raster)

» IEE

Input file (shapefile) large_rivers n Select...

Attribute field ARCID v

Qutput file for rasterized vectors (raster) e2/qais/rasterized_rivers. tif

Keep existing raster size and resolution

® Raster size in pixels

-~

Width | 3000 =

4

Height ' 3000

Raster resolution in map units per pixel

% Load into canvas when finished

gdal_rasterize -a ARCID -ts 3000 3000 4 large_rivers ‘ : ‘
C:/Users/raceclark/Desktop/EF5_training/examples/example2/qais/large_rivers.shp | ——
C:/Users/racedark/Desktop/EF5_training/examples/example2/qgis/rasterized_rivers ‘ ‘
Aif I~

OK Close Help
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Converting Rivers

Click the pencil icon down
near the bOttom Ly Rasterize (Vector to raster)

In the text box, delete -a E
replace it with -burn -10 -
te -75 4 -73 6 -tr 0.02
0.02

»
4>

4/»
4/»

We are tel I i n g QG I S to Write % Load into canvas when finished -
the number -10 every pixel In | oo pevommivere. [
W h I c h a r I ve r occ u r S ] u s I n g C t 1{Users/racedark/De'sktop/EF5_tra|n|ng/examples/example2/qg|s/rastenzed_rlvers ‘ i ‘
the same extent and

resolution as the DEM we

OK Help
already created
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Burning Rivers

Click “OK”, “OK”, and

then “Close” d

L
LT
i

)
You should see - j
something like this > M y

Now remember the
dark cells have values
of -10

,:—%\"

Let’s add the rivers to
the DEM...
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Burning Rivers

In the “Raster’” menu, select
k6 Raster Calcu Iator” Ly Raster calculator

Raster bands Result layer

"Pit Removed Elevation Grid@1” Output layer amples/example2/qgis/burned_dem | | ...
“dipped_dem@1”

In the “Output Layer” box, save = ="

Current layer extent

. N Xmin | -75.00000 S XMax | -73.00000 =
the file as burned dem.tif vmin (400000 </ vmax [6.00000 -
- Columns | 100 : Rows 100 :
Output format GeoTIFF v
R Add result to project

In “Raster bands”, double-click |
the “Pit Removed Elevation - - - :
Grid” - / cis asi_n tai atan )

AND OR

Raster calculator expression

In the box at the bottom, after

Pit Removed Elevation

Grid@i, type +()*3 then move

your cursor between the

parentheses and double-click
“rasterized_rivers@1”
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Burning Rivers

Click “OK” and you should
see this 2

We basically lowered the
elevation of each pixel in the
river channel by 30 meters

This is called “burning the
rivers into the DEM”

To be safe, we’re going to
remove pits one last time
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Creating the Final DEM

In “Recently used algorithms”,
double-click “Pit Remove”

. . 4 Pit Remove n
For “Elevation Grid”, select
“burned _dem”’

Parameters Log Help

Elevation Grid

. burned_dem [EPSG:4326] v I]
Use the “...” button and CIICk Pit Removed Elevation Grid -
113 Save to fi I e . HH to Save yo u r P it C:/Users/racedark/Desktop/EF5_training/examples/example2/qgis/dem. tif ‘7

% Open output file after running algorithm

Removed Elevation Grid as
dem.tif inyour qgis folder

This is the final DEM

(I recommend removing the
old “Pit Removed Elevation

Grid” from the Layers panel

to avoid confusion)

Do this by right-clicking on it
and selecting “Remove” ! 0%

Run Close
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Let’s review again

1. We set up our QGIS project with rivers, a gauge outlet,
and a DEM

2. We used the gauge outlet and the rivers to identify the
edges of our river basin

3. We resampled the DEM to a new resolution and extent

4. We used our filtered rivers to “burn” the streams back
into the resampled DEM, while also removing the pits
and other errors

Now on to the next step: Creating flow direction and
flow accumulation maps
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Creating a Flow Direction

In “Processing Toolbox”, open “TauDEM (hydrologic
analysis)”, then open “Basic Grid Analysis tools” and
finally double-click “D8 Flow Directions”

For “Pit Filled Elevation Grid” select “Pit Removed
Elevation Grid”

By “D8 Flow Direction Grid”, select “...” and then “Save
to file...”

Save the file as flow dir.tif inyour qgis folder
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Creating a Flow Direction

Click “Run” and remove “D8 Slope” from your “Layers”
panel...

Pit Filled Elevation Grid
Pit Removed Elevation Grid [EPSG:4326]

D8 Flow Direction Grid
C:/Users/racedark/Desktop/EF5_training/examples/example2/qgis/flow_dir. tif

% Open output file after running algorithm
D8 Slope Grid

%/ Open output file after running algorithm
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Converting the Flow Direction

. A Translate (Convert forma
We need to convert this to a format EF5 can read e
In the “Raster” menu, select “Conversion” and e [
then “Translate (Convert Format)...”
In “Input Layer”, select “D8 Flow Direction Grid” =
In “Output file”, save this file as fdr.tif inyour | ..
qgis folder v O reaen pters
Then click the pencil at the bottom and type -ot
Float32 in place of -of GeoTIFF after
gdal translate —
CIiCk “OK,,, “OK,,, and “Close” EZE.]I/%%%?%};:?;L?;&(%;/EF5_training/examples/example2/

g;i/;J/sfg;sﬁ/_;acedark/Desktop/EFS_training/examples/example2/ i

This is your final flow direction grid —
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Creating an FAC

Finally, it’s time to create
the FAC

In the “Processing
Toolbox”, go to “TauDEM
(hydrologlc analysis)” and
then “Basic Grid Analysis
tools” and then “D8
Contributing Area”

Select “fdr” for the “D8
Flow Direction Grid” and
then save the “D8
Contributing Area Grid”
as fac.tif inyour qggis
folder

D8 Contributing Area | x |

Parame ters Log Help

D8 Flow Direction Grid
fdr [EPSG:4326]
Outlets Shapefile [optional]
[Not selected] v ‘ r* ) ‘
Weight Grid [optional]
[Not selected] v
% Check for edge contamination
D8 Contributing Area Grid
C:/Users/raceclark/Desktop/EF5_training/examples/example2/qais/fac. tif ‘:‘
% Open output file after running algorithm

0%
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Creating an FAC

Click “Run”

You should get something like
this -

What’s really important is that
the gauge point, in the red box,
looks like the river flowing into
it properly follows the path of
the original rivers shapefile
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Check the FAC

The drainage area of the Bogota at Puente Portillo is
about 6,000 km?2

In QGIS | can use the “ldentify Features” tool to find
the value of the FAC at the outlet point

Click the “Identify Features” icon > €&

. Identify Resuks (&)%)
Then at the lower left, a new pane called “ldentify IE@E % ©
Results” appears =

Use the drop-down menu to select “View” as “Table”

Now click a white cell near your gauge point, and on « | an
the popup menu, select “D8 Contributing Area Grid” "= o=t = [ iawooenfom |
View Tree v Help
Era—

_____
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Check the FAC

Scroll to the right in the “ldentify Results” pane until you
reach the “Value” column

| got a “Value” of 1075
So, 1075 grid cells are draining into the point | selected

Each grid cell is 2 km on a side, or 4 km?
1075 times 4 km? yields 4250 km?

We should get an area somewhere between 5000 and 6000
km? and the shortfall is probably due to changing the
resolution of the DEM
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Prepare Files for EF5

Save your QGIS project in your qgis folder and exit QGIS

Out of all the files now in your qgis folder, we care about
dem.tif, fac.tif, and fdr.tif

Copy these three files to EF5 training\examples
\example2\basic

IS = | basic —an
“ Home  Share  View @

(-' + 1 » ThisPC » Desktop » EF5_training » examples » example2 » basic v ¢ Search basic o
X Favorites Name Date Type Size Tags
B Desktop & dem.tif 5/14/2015 1:01 PM TIFF image 40 KB
& Downloads & fac.tif 5/14/2015 1:14 PM TIFF image 40 KB
| Recent places & fdr.tif 5/14/2015 1:10 PM TIFF image 40 KB
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Prepare Files for EF5

Now open the control.txt file in the example2 folder

""" | control.txt - Notepad - o IEl
File Edit Format View Help

[Basic] A
DEM=basic\dem.tif

DDM=basic\ddm.tif

FAM=basic\fac.tif

PROJ=geographic

ESRIDDM=false

SelfFAM=true

Our first job is to check the Basic block

* This block tells EF5 where the topographical information
is stored relative to the location of control.txt

 So, DEM= should be the file path to the DEM, and so on

 control.txt isinthe example2 folder, and from there to

find my DEM, DDM/FDR, and FAC, | simply enter the basic
folder and the appropriate files are inside
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Prepare Files for EF5

 PROJ=geographic tells EF5 that all three files (DEM, DDM/
FDR, and FAC) are in the geographic projection (and we know
they are, because we used latitude and longitude to add the
gauge outlet)

 ESRIDDM=false tells EF5 what coding scheme is used in the
DDM/FDR file; since itis false we are saying we used the
TauDEM coding scheme (1, 2, 3, 4, 5, etc.) and not the ArcMap
coding scheme (1, 2, 4, 8, 16, etc.)

- Finally, selfFAM=true means that the lowest value of any cell
in the FAC is 1 (in other words, a cell counts itself in the FAC
generation cgrocess you can test this by looking in the “Layers”
panel of QGIS, which shows that the lowest FAC value is 1

control.txt - Notepad - o IEl
File Edit Format View Help

[Basic] A
DEM=basic\dem.tif

DDM=basic\ddm.tif

FAM=basic\fac.tif

PROJ=geographic

ESRIDDM=false

SelfFAM=true
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Prepare Files for EF5

From EF5_training\data\Observations, copy Id9-e-=

puente_portillo.csv to EF5_training\examples BED fome | mset  page Layout

\example2\obs SR T A
33 -

Paste B 7 U~ i~ Oy~ ﬁ
This file is the observed time series of daily discharge at Cm;m" | -
the Puente Portillo station between 1 January 1998 and ™

> f | D
31 December 2010 : 5
. The first column is the date and time BllD:te (dd/mm/yyyy) Imean Q (m#3/s)
. The second column is the discharge value in cubic 2 1/1/1998 0:00 4.9
meters per second 3 1/2/1998 0:00 6.6
4 1/3/1998 0:00 6.8
. . . 5 1/4/1998 0:00 5.6
EF5 supports 3 formats for reading in observed time : 1/5/1998 0:00 T
series 7 1/6/1998 0:00 44.9
. YYYY/MM/DD HH:UU:SS (like in the 8 1/7/1998 0:00 13
puente portillo.csv example) 9 1/8/1998 0:00 5.8
*  YYYY-MM-DD HH:UU:SS (so dashes instead of = 145/ 1998 0:00 3
SlaSheS) 11 1/10/1998 0:00 5.1
© MM-DD-YYYY T —
* MM/DD/YYYY 14 1/13/1998 0:00 10.1
° Note that Y = year, M= month, D= day, H= hour, U= 15 1/14/1998 0:00 5.8
minute, and S = second 16 1/15/1998 0:00 7.3
17 1/1A/19402 n-nn A
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Prepare Files for EF5

We’ve added files to the basic folder and to the obs folder

The output folder will be filled with the model results after
the simulation

We will fill pet and precip in Module 2.3

2 LS = | example2 - o IEH
“ Home Share View 0

(—\ - 1 » ThisPC » Desktop » EF5_training » examples » example2 » v ¢ Search example2 P
' Favorites Name Date modified Type Size

Bl Desktop basic 5/14/2015 1:24 PM File folder
& Downloads obs 5/14/2015 1:29 PM File folder
=, Recent places output 2/5/2015 2:07 PM File folder
pet 2/5/2015 2:07 PM File folder
1% This PC precip 2/5/2015 2:07 PM File folder
m Desktop qgis 5/14/2015 1:24 PM File folder

~| Documents control.txt 3/24/20153:07PM  Text Document 1 KB
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Coming Up....

The next module is
Rainfall and PET

You can find it in your \EF5 training\presentations
directory
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